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Оценка упругих свойств высокопористых имплантантов для пострезекционных дефектов, образующихся после хирургической резекции / Матюшонок Анна Дмитриевна; Механико-математический факультет, Кафедра био- и наномеханики; науч. рук. К.С.Юркевич.

Дипломная работа содержит:
· 45 страниц;
· 44 иллюстраций;
· 1 таблица;
· 5 использованных источников.

Ключевые слова: регулярная пористая структура; эффективный модуль упругости; бедренная кость человека; губчатая костная ткань; радиус стержня; конечно-элементное моделирование.
Целью данной дипломной работы является определение геометрических параметров модели регулярной пористой структуры с низкой плотностью открытых ячеек для того, чтобы достигнуть максимального соответствия между упругими свойствами костной ткани и имплантанта.
В дипломной работе получены следующие результаты:
· разработана конечно-элементная модель бедренной кости человека с учетом реального распределения минеральной плотности губчатой и кортикальной костной ткани;
· разработана параметризованная модель регулярной пористой структуры;
· определена зависимость эффективного модуля упругости пористой структуры от геометрических и механических параметров;
· проведен сравнительный анализ эффективных модулей упругости пористой структуры и губчатой костной ткани;
· определены геометрические параметры пористой структуры, при которых достигается максимальное соответствие упругих свойств костной ткани и имплантанта.

Дипломная работа носит практический характер. Полученные результаты могут быть применены при планировании операций по удалению опухолей в длинных трубчатых костях человека.
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Ацэнка пругкіх уласцівасцяў высакапорыстыя імплантантаў для пострэзекціённых дэфектаў, якія ўтвараюцца пасля хірургічнай рэзекцыі / Мацюшонак Ганна Дзмітрыеўна; Механіка-матэматычны факультэт, Кафедра бія- і нанамеханікі; наву. рук. К. С. Юркевич.

Дыпломная праца змяшчае:
· 45 старонак;
· 44 малюнкаў;
· 1 табліца;
· 5 крыніц.

Ключавыя словы: рэгулярная порыстая структура; эфектыўны модуль пругкасці; сцегнавая костка чалавека; губчатая касцяная тканіна; радыус стрыжня; вядома-элементнае мадэляванне.
Мэтай дадзенай дыпломнай працы з'яўляецца вызначэнне геаметрычных параметраў мадэлі рэгулярнай порыстай структуры з нізкай шчыльнасцю адкрытых ячэяк для таго, каб дасягнуць максімальнай адпаведнасці паміж пругкімі ўласцівасцямі касцяной тканіны і імплантанта.
У дыпломнай працы атрыманы наступныя вынікі:
· распрацавана вядома-элементная мадэль сцегнавой косткі чалавека з улікам рэальнага размеркавання мінеральнай шчыльнасці губчатай і кортикальной касцяной тканіны;
· распрацавана параметризованная мадэль рэгулярнай порыстай структуры;
· вызначана залежнасць эфектыўнага модуля пругкасці порыстай структуры ад геаметрычных і механічных параметраў;
· праведзены параўнальны аналіз эфектыўных модуляў пругкасці порыстай структуры і губчатай касцяной тканіны;
· вызначаны геаметрычныя параметры порыстай структуры, пры якіх дасягаецца максімальнае адпаведнасць пругкіх уласцівасцяў касцяной тканіны і імплантанта.

Дыпломная праца носіць практычны характар. Атрыманыя вынікі могуць быць ужытыя пры планаванні аперацый па выдаленні пухлін ў доўгіх трубчастых костках чалавека.
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Evaluation of the elastic properties of highly porous implants for postresection defects, formed after surgical resection / Matyushonok Anna Dmitrievna; Faculty of Mechanics and Mathematics, Department of Bio- and Nanomechanics; Sci. Hands. K. S. Yurkevich.

Research contains:
· 45 pages;
· 44 illustrations;
· 1 tables;
· 5 sources.

Key words: regular porous structure; effective modulus of elasticity; the femur of a man; spongy bone; radius of the rod; finite element modeling.
The purpose of this work is to determine the geometric parameters of a model of a regular porous structure with a low density of open cells in order to achieve the maximum correspondence between the elastic properties of bone tissue and implant
The following results were obtained:
· a finite-element model of the human femur bone has been developed, taking into account the actual distribution of mineral density of spongy and cortical bone tissue;
· a parametrized model of a regular porous structure has been developed;
· the dependence of the effective modulus of elasticity of a porous structure on geometrical and mechanical parameters;
· a comparative analysis of the effective elastic moduli of the porous structure and spongy bone tissue;
· the geometrical parameters of the porous structure are determined, at which the maximum compliance of elastic properties of bone tissue and implant is achieved

This theme has a strong practical base. The results obtained can be applied in the planning of operations to remove tumors in long human tubular bones.


[bookmark: _Toc516432163]ВВЕДЕНИЕ
Пористые материалы широко распространены в природе, например, в лесу, внутри кости и во многих других живых тканях. В инженерии их применение возрастает с каждым годом. Это связано с низкой массой и особыми свойствами, которыми они обладают. Поведение таких структур с точки зрения механики регулируется их внутренним строением. Как правило, в природе существуют лишь нерегулярные структуры. Влияние нерегулярности структуры на несущие способности и надежность не до конца изучены в настоящее время [3].
В настоящей работе представлены результаты определения модулей упругости регулярной пористой структуры с низкой плотностью открытых ячеек методом конечных элементов при различных радиусах поперечных сечений стержней, образующих пористую структуру и упругих свойствах материала. Параметризованная модель пористой структуры разработана в программном комплексе ANSYS. Граничные условия соответствуют одноосному нагружению образца. Выполнен сравнительный анализ модулей упругости пористых структур и усредненных модулей упругости образцов губчатой костной ткани из различных участков проксимального отдела бедренной кости человека. Модель бедренной кости разработана на основании томографических данных с учетом распределения минеральной плотности костной ткани. Определены геометрические параметры регулярной пористой структуры, при которых модуль упругости структуры совпадает с усредненным модулем упругости губчатой костной ткани. Полученные результаты могут быть использованы при разработке имплантантов для бедренных костей, используемых для проксимального отдела бедра.
Дипломная работа состоит из трех глав. Первая глава представляет собой разработку конечно-элементной модели бедренной кости человека с учетом реального распределения минеральной плотности губчатой и кортикальной костной ткани. Вторая глава посвящена моделированию параметризованной конечно-элементной модели регулярной пористой структуры и определению зависимости эффективного модуля упругости от геометрических и механических параметров. Третья глава включает в себя сравнительный анализ эффективного модуля упругости регулярной пористой структуры и образцов губчатой костной ткани.


[bookmark: _Toc516432164]ГЛАВА 1
Разработка конечно-элементной модель
бедренной кости человека 
[bookmark: _Toc516432165]Генерация трехмерной твердотельной геометрической модели бедренной кости человека

При разработке конечно-элементной модели бедренной кости человека с учетом реального распределения минеральной плотности губчатой и кортикальной костной ткани было использовано 717 снимков магнитно-резонансной томографии бедренной кости живого человека. Шаг томографа был задан 5 мм. Для генерации трехмерной модели бедренной кости человека была применена программа для обработки медицинских изображений MIMICS 20.0 (Materialise's Interactive Medical Image Control Systems, Materialise BV, Leuven, Belgium). 
Импортирование DICOM изображений, которые являются продуктом создания, хранения, передачи и визуализации медицинских изображений, в том числе МРТ, было осуществлено в командном режиме с использованием пункта меню File → New Project Wizard. В открывшемся окне выбираем директорию, в которой хранятся томографические снимки бедренной кости человека. На следующем шаге открывается диалоговое окно Studies, в котором происходит дальнейшая настройка для импортирования изображений. Нажав кнопку Convert в окне Studies, появляется новое диалоговое окно, в котором происходит проверка ориентации изображений в сагиттальной, фронтальной и аксиальной плоскостях, это необходимо для корректного построения 3D модели[5].
На рисунке 1.1 представлен результат импорта снимков магнитно-резонансной томографии бедренной кости живого человека в программу Mimics 20.0.

[image: ]
Рисунок 1.1 – Импортированные томографические снимки в программу для обработки
медицинских изображений Mimics

3D модель в программе Mimics 20.0 строится на основании маски, для ее создания воспользуемся функцией Thresholding. Она предназначена для выбора нижнего и верхнего порога значений индекса Хаунсфилда цветовой маски. Маска будет включать только те пиксели изображений МРТ, которые содержаться между заданными пороговыми значениями [5]. Значение нижнего порога задаем равным 340 HU, верхнее оставляем максимальным, равным 1613 HU, как показано на рисунке 1.2.
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Рисунок 1.2 – Панель инструментов диалогового
окно функции Thresholding

Функцией Region Growing пользуемся для того, чтобы удалить ненужные пиксели, которые включились в маску в ходе работы функции Thresholding. С помощью этой функции была сгенерирована новая маска, к которой на следующем шаге была применена функция Split Mask, вызов которой выполняется из меню Segment. Эта функция позволяет отделить от бедренной кости человека тазобедренный сустав. В ходе работы этой функции создаются 2 новые маски [5]. Маска бедренной кости, из которой в дальнейшем будет построена 3D модель, показана на рисунке 1.3.

[image: ]
Рисунок 1.3 – 3D вид маски бедренной кости человека

[bookmark: _Hlk515477340]Генерация 3D модели бедренной кости человека выполняется с помощью функции Calculate Part from mask, переключателем справа выставляется свойство Optimal. Это свойство позволяет затратить оптимальное количество вычислительных ресурсов и машинного времени на создание модели, а также уменьшить используемое количество оперативной памяти [5]. Диалоговое окно этой функции представлено на рисунке 1.4.
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Рисунок 1.4 – Диалоговое окно функции Calculate Part from mask

Поскольку полученная модель бедренной кости человека для конечно-элементного анализы имеет слишком большое количество треугольников, составляющих ее поверхность, необходимо их перераспределить. Для этого пользуемся функцией Reduce [5]. Окно этой функции и заданные параметры отображены на рисунке 1.5.

[image: ]
Рисунок 1.5 – Диалоговое окно функции Reduce с заданными
параметрами для перераспределения треугольников

Модель бедренной кости будет использоваться только для конечно-элементного анализа, следовательно, можно воспользоваться функцией Smooth, которая позволяет уменьшить количество деталей внешней поверхности модели путем сглаживания [5]. Вызов функций Smooth и Reduce выполняется из меню 3D Tools, диалоговое окно с заданными параметрами сглаживания показано на рисунке 1.6.
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Рисунок 1.6 – Диалоговое окно функции Smooth
с заданными параметрами сглаживания

[bookmark: _Hlk515483027]В результате генерации модели и применения вышеописанных функций на поверхности модели имеются небольшие полости. В программе Mimics 20.0 есть функция, позволяющая заполнить эти полости путем создания обволакивающей поверхности. Вызов функции Wrap выполняется в командном режиме из меню 3D Tools [5]. Использование этой функции при создании модели для конечно-элементного анализа является необходимым, диалоговое окно с заданными параметрами представлено на рисунке 1.7.
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Рисунок 1.7 – Диалоговое окно функции Wrap
с заданными параметрами

После выполнения вышеописанных действий была сгенерирована трехмерная твердотельная геометрическая модель бедренной кости человека, она представлена на рисунке 1.8.
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Рисунок 1.8 – Трехмерная твердотельная геометрическая
модель бедренной кости человека

[bookmark: _Toc516432166]Разбиение полученной твердотельной модели на конечные элементы, задание свойств материала губчатой и кортикальной костной ткани

Программный модуль 3-matic 12.0 позволяет построить конечно-элементную модель на основе сгенерированной ранее геометрической твердотельной модели в Mimics 20.0. Для того, чтобы экспортировать 3D модель в этот модуль существует несколько способов, воспользуемся самым простым, в открытом окне программы Mimics нажимаем сочетание клавиш Ctrl + C и выбираем нужную модель из списка, открываем программный модуль 3-matic и нажимаем сочетание клавиш Ctrl + V. Модель экспортирована.
[bookmark: _Hlk515485483]Во вкладке Remesh выбираем функцию Uniform Remesh. Эта функция создает сетку с однородными треугольниками, однако ее использование может привести к серьезным геометрическим ошибка, для 3D модели бедренной кости человека такие ошибки отсутствуют [5]. Меню функции Uniform Remesh показано на рисунке 1.9.

[image: ]
Рисунок 1.9 – Меню функции Uniform Remesh с
заданной длиной ребра треугольников

[bookmark: _Hlk515485955]В той же вкладке выбираем функцию Create Volume mesh. Эта функция генерирует тетраэдрическую объемную сетку, это необходимо для дальнейшего задания свойств материала [5]. Меню функции Create Volume mesh показано на рисунке 1.10.
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Рисунок 1.10 – Меню функции Create Volume mesh
с заданным размером элемента

Для визуализации выполнения функции Create Volume mesh необходимо рассечь кость одной из плоскостей. Для начала в меню Object tree выбираем Section list, затем выбираем плоскость, кликаем правой кнопкой мыши по нужному разделу и выбираем Show. В диалоговом окне выбранного раздела ставим галочку в области Clip и перетаскиваем ползунок в графе Position [5]. Результат выполнения этих действий и визуализация работы функции Create Volume mesh показано на рисунке 1.11.

[image: ]
Рисунок 1.11 – Дискретная модель бедренной кости человека

Работа в программном модуле 3-matic 12.0 закончена.
Чтобы задать полученной дискретной модели механические свойства, соответствующие реальному распределению плотности кости, модель нужно экспортировать обратно в программу Mimics 20.0. Для этого выделяем модель в списке справа, нажимаем сочетание клавиш Ctrl + C, открываем программу Mimics 20.0 и нажимаем сочетание клавиш Ctrl + V. Модель экспортирована и отображается во вкладке FEA Mesh. В нижней части этой вкладки выбираем функцию Materials, значок которой выглядит следующим образом: [image: ] . Эта функция позволяет в зависимости от индекса Хаунсфилда (HU) задавать свойства материала [5]. Окно этой функции представлено на рисунке 1.12.

[image: ]
Рисунок 1.12 – Диалоговое окно функции Materials

Гистограмма в нижней части рисунка 1.12 отображает число элементов (по вертикальной оси) в зависимости от значения индекса Хаунсфилда (по горизонтальной оси). Количество цветов гистограммы соответствует числу материалов, которое задается в графе Number of materials. 
Создадим 2 типа материала, в верхней части диалогового окна функции Materials, которое показано на рисунке 1.12, рядом со вкладкой Material type 1 нажимаем знак «+», создается еще одна вкладка, которая называется Material type 2. Это позволяет использовать разные зависимости для определения плотности, модуля упругости и коэффициента Пуассона на конкретных отрезках значения индекса Хаунсфилда. 
Для первой вкладки, которая называется Material type 1 задаем в графе Number of materials значение «1». Для второй вкладки в этой же графе – 10.
Следующим шагом задаем пограничное значение индекса Хаунсфилда. Для этого на гистограмме можно перетягивать ползунок, либо в графе Gray value range задать точное значение максимума для первой вкладки, либо минимума для второй. В случае бедренной кости человека это пограничное значение равно 100 Hu [2].
Зададим свойства материала во вкладке Material type 1, плотность будет постоянной и равной 50 кг/м3. Для этого ставим галочку в графе Density и переключатель во второе положение. В графе Young’s modulus ставим галочку и вводим зависимость для модуля упругости, которая приведена в формуле 1.


(1)						


где  – модуль упругости (измеряется в МПа),  – заданная плотность (измеряется в кг/м3) [2].
Коэффициент Пуассона равен 0,3. Результат вышеописанных действий показан на рисунке 1.13.
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Рисунок 1.13 – Результат задание свойств материала для материалов типа Material type 1

Задаем свойства материала для материалов типа Material type 2, для этого переходи во вкладку с соответствующим названием. Плотность будет задаваться в диапазоне от 50 до 1900 кг/м3, для этого в графе Density ставим галочку и переключатель в первое положение, в первой ячейке записываем пограничное значение индекса Хаунсфилда (100 Hu), в ячейке, расположенной после знака равно, значение плотности для данного значения индекса Хаунсфилда (50 кг/м3). Во второй ячейке задаем максимальное значение индекса Хаунсфилда (1600 Hu), а после знака равно значение плотности в этой точке (1900 кг/м3). Получаем 10 промежуточных значений плотности. Этот способ соответствует зависимости, описанной в формуле (2) [2]. Используя зависимость для модуля упругости, которая приведена в формуле (2), задаем модуль упругости, предварительно поставив галочку в графе Young’s modulus. Коэффициент Пуассона остается равным 0,3.




(2) 				







где  – денситометрических показателей, – эквивалентная плотность гидроксиапатита кальция в костной ткани (измеряется в г/см3),  – объемная плотность (измеряется в кг/м3),  – модуль упругости (измеряется в МПа) [2].
Визуализация вышеописанных шагов представлена на рисунке 1.14.
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Рисунок 1.14 – Результат задание свойств материала для материалов типа Material type 2

Нажимаем кнопку Apply, затем Close. В результате всех вышеописанных шагов была получена конечно-элементная модель бедренной кости человека с учетом реального распределения минеральной плотности губчатой и кортикальной костной ткани, она представлена на рисунке 1.15.

	[image: ]
	[image: ]

	1
	2


Рисунок 1.15 – Конечно элементная модель бедренной кости человека с учетом реального
распределения минеральной плотности губчатой и кортикальной костной ткани

[bookmark: _Toc516432167]Экспорт полученной конечно-элементной модели бедренной кости человека

Для того, чтобы работать с этой моделью в других системах, проводить расчеты и определять ее напряженно-деформированное состояние, необходимо экспортировать конечно-элементную модель бедренной кости человека с учетом реального распределения минеральной плотности губчатой и кортикальной костной ткани в файл с соответствующим форматом. Открываем меню File → Export → Ansys. В появившемся окне во вкладке Mesh в списке моделей находим нужную и в нижней части окна нажимаем кнопку Add. Необходимо так же выбрать папку для сохранения экспортируемой модели и расширение этого файла. Для того, чтобы в Ansys Workbench модель загрузилась с заданными типами материалов необходимо выбрать расширение *.inp [5]. Модель экспортирована.


[bookmark: _Toc516432168]Глава 2
Разработка конечно-элементной модели
регулярной пористой структуры
[bookmark: _Toc516432169]2.1	Разработка кода на языке APDL для генерации конечно-элементной модели регулярной пористой структуры

Параметризованная модель регулярной пористой структуры с низкой плотностью открытых ячеек разработана в пакете конечно-элементного анализа ANSYS APDL 17.2. Параметризация модели выполнена для автоматизированного изменения количества и геометрических размеров базовой ячейки пористой структуры, параметров радиуса поперечного сечения стержня и его физико-механических свойств. Программирование выполнялось через командную строку.
Генерация модели начинается с задания констант, таких, как максимальная длина ребра параллелепипеда вдоль каждой оси, расстояние между узлами для каждой оси координат, число узлов в одном ряду по направлению каждой из осей координат, радиус поперечного сечения стержня.
После этого генерируются узлы, для этого используется обычный цикл do. В качестве примера возьмем модель регулярной пористой структуры 32x32x32 мм3, 8x8x8 ячеек, радиус стержня r = 0,409 мм [1]. Сгенерированные узлы показаны на рисунке 2.1.

[image: ]
Рисунок 2.1 – Результат выполнения цикла для генерации узлов

Определим тип элемента для стержней, которые соединят сгенерированные узлы. Зададим Beam188 — это двух узловая балка, основанная на балочной теории Тимошенко, у этой балки 6 степеней свободы в каждом узле [4]. В качестве поперечного сечения балки выбираем круговое сечение.
Следующим шагом соединяем узлы элементами, генерация элементов проводится с использованием цикла do. Элементы строятся последовательно для каждой из трех осей. Были получены соответствующие функции, которые позволяют соединять узлы стержнями в направлении любой из трех осей только параллельно этой оси. 
Разработанная параметризованная модель регулярной пористой структуры с низкой плотностью открытых ячеек представлена на рисунке 2.2.
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Рисунок 2.2 – Параметризованная модель регулярной пористой
структуры с низкой плотностью открытых ячеек

Механические свойства стержней, которые соединяют узлы: модуль упругости стержня Е = 1,7 ГПа, коэффициент Пуассона ν = 0,3 [1].

[bookmark: _Toc516432170]2.2	Задание граничных условий для полученной конечно-элементной модели регулярной пористой структуры

Для удобства и простоты работы с моделью и задания граничных условий были созданы два множества. Первое множество состоит из узлов, расположенных в плоскости z = 0 (узлов, принадлежащих нижнему основанию структуры). Второе множества включает в себя узлы, лежащие в плоскости z = h верхнего основания (h – высота пористой структуры).
Граничные условия для модели соответствуют жесткому закреплению всех узлов, принадлежащих первому множеству. К узлам из второго множества прикладывается вертикальная сжимающая нагрузка [1]. Следует отметить, что общую нагрузку необходимо разделить на число узлов, лежащих в плоскости верхнего основания.

[bookmark: _Toc516432171]2.3	Определение эффективного модуля упругости для разработанной конечно-элементной модели регулярной пористой структуры

Эффективный модуль упругости пористой структуры определяется по формуле 3.


(3)	

где E – эффективный модуль упругости; P – нормальная составляющая силы; l0 – начальная длина; F – площадь поверхности по которой распределено действие силы;  – перемещение верхней грани вдоль оси z.
Для того, чтобы просмотреть перемещения в ANSYS APDL, необходимо запустить расчет модели, затем зайти в General Postproc. Если работать, через меню пользователя, то следует последовательно нажимать следующие клавиши: List Results → Nodal Solution →DOF Solution → Z-component of displacement. Появляется окно с перемещениями для каждого узла. Максимальное по модулю перемещение используется для определения эффективного модуля упругости. 

Перемещение верхней грани (z = h) модели, которая была взята в качестве  примера,  вдоль  оси z,  приложенная  нагрузка равна  100 Н,  равно -0.44130×10-4м. Используя формулу (3), получаем эффективный модуль упругостиПа.

[bookmark: _Toc516432172]2.4	Влияние геометрических и механических параметров на модуль упругости регулярной пористой структуры

Рассмотрим три модели с различным количеством ячеек, чтобы определить влияние геометрических параметров на модуль упругости регулярной пористой структуры. Для всех моделей шаг сетки остается постоянным, он равен 4 мм. Объем первой модели регулярной пористой структуры 32x32x32 мм3 (8x8x8 ячеек), второй – 36x36x36 мм3 (9x9x9 ячеек), третьей – 40x40x40 мм3 (10x10x10 ячеек). Эти модели представлены на рисунках 2.3–2.5.
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Рисунок 2.3 – Конечно-элементная модель регулярной пористой
структуры объемом 32x32x32 мм3 (8x8x8 ячеек); 

[image: ]
Рисунок 2.4 – Конечно-элементная модель регулярной пористой
структуры объемом 36x36x36 мм3 (9x9x9 ячеек); 


[image: ]
Рисунок 2.5 – Конечно-элементная модель регулярной пористой
структуры объемом 40x40x40 мм3 (10x10x10 ячеек)

Сила, приложенная к одному узлу верхней грани, равна 0,2 Н. Для каждой из моделей, представленных на рисунках 2.3–2.5, это значение будет умножаться на число узлов, лежащих в верхней плоскости. Для каждой модели был посчитан эффективный модуль упругости по формуле 3. На рисунке 2.6 представлен график зависимости эффективного модуля упругости от количества ячеек модели, шаг сетки постоянный.

[image: ]
Рисунок 2.6 – График зависимости эффективного модуля упругости
регулярной пористой структуры от количества ячеек этой структуры

Установлено, что эффективный модуль упругости не зависит от количества ячеек и для каждой из моделей, представленных на рисунках 2.3-2.5, составляет 70,8 МПа (радиус стержня r = 0,409 мм, модуль упругости стержня Е = 1,7 ГПа) [1]. Таким образом, можно сделать вывод, что количество ячеек не влияет на эффективный модуль упругости регулярной пористой структуры.
Рассмотрим регулярные пористые структуры, объем которых 32x32x32 мм3 (8x8x8 ячеек), модуль упругости стержня Е = 1,7 Гпа, коэффициент Пуассона ν = 0,3 [1]. Будем изменять радиус поперечного сечения стержня от 0,1 мм до 0,6 мм. Эти структуры приведены на рисунках 2.7-2.12.
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Рисунок 2.7 – Конечно-элементная модель регулярной пористой структуры
объемом 32x32x32 мм3 (8x8x8 ячеек), радиус r = 0,1 мм
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Рисунок 2.8 – Конечно-элементная модель регулярной пористой структуры
объемом 32x32x32 мм3 (8x8x8 ячеек), радиус r = 0,2 мм
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Рисунок 2.9 – Конечно-элементная модель регулярной пористой структуры
объемом 32x32x32 мм3 (8x8x8 ячеек), радиус r = 0,3 мм
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Рисунок 2.10 – Конечно-элементная модель регулярной пористой структуры
объемом 32x32x32 мм3 (8x8x8 ячеек), радиус r = 0,4 мм
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Рисунок 2.11 – Конечно-элементная модель регулярной пористой структуры
объемом 32x32x32 мм3 (8x8x8 ячеек), радиус r = 0,5 мм
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Рисунок 2.12 – Конечно-элементная модель регулярной пористой структуры
объемом 32x32x32 мм3 (8x8x8 ячеек), радиус r = 0,6 мм

Для каждой структуры по формуле 3 был определен эффективный модуль упругости. С помощью пакета Wolfram Mathematica 10.0 строим график зависимости модуля упругости от радиуса поперечного сечения, он представлен на рисунке 2.13.
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Рисунок 2.13 – График зависимости эффективного модуля упругости регулярной
пористой структуры от радиуса поперечного сечения стержня

Установлено, что с увеличением радиуса поперечного сечения стержня, модуль упругости регулярной пористой структуры возрастает. Таким образом, можно сделать вывод, что радиус поперечного сечения стрежня влияет на эффективный модуль упругости регулярной пористой структуры.
Механические параметры регулярной пористой структуры, например модуль упругости балки, влияют на эффективный модуль упругости. С увеличением модуля упругости стержня эффективный модуль упругости всей структуры тоже увеличивается.
Программа для генерации параметризованной конечно-элементной модели регулярной пористой структуры с заданием граничных условий представлена в Приложении А.


[bookmark: _Toc516432173]Глава 3
сравнительный анализ эффективных модулей
упругости пористой структуры
и губчатой костной ткани
[bookmark: _Toc516432174]3.1	Выделение образца губчатой костной ткани из проксимального отдела модели бедренной кости человека

Из проксимального отдела модели бедренной кости человека с учетом реального распределения минеральной плотности губчатой и кортикальной костной ткани, которая была разработана в ходе данной работы, было выделено три образца в форме параллелепипеда. Области, из которых были получены исследуемые образцы обозначены на рисунках 3.1-3.3.
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Рисунок 3.1 – Область, из которой выделен первый образец губчатой костной ткани,
использованный при определении модуля упругости
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Рисунок 3.2 – Область, из которой выделен второй образец губчатой костной ткани,
использованный при определении модуля упругости
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Рисунок 3.3 – Область, из которой выделен третий образец губчатой костной ткани,
использованный при определении модуля упругости

В программном модуле Mimics 20.0 после создания маски, как описано в главе 1 настоящей работы, используем функцию Crop Mask, с помощью которой можно выделить нужную область. С помощью этой функции было выделено 3 образца губчатой костной ткани из проксимального отдела бедренной кости человека. Полученные 3D модели образцов с учетом реального распределения минеральной плотности губчатой костной ткани были экспортированы в файлы формата *.inp и загружены в Ansys Workbench для проведения конечно-элементного анализа этих образцов. Чтобы импортировать каждый *.inp файл, необходимо выполнить следующие действия. Перетащить в рабочую область Project Schematic компонент External Model. Затем в эту же область перетащить необходимый вид расчета, выбираем Static Structural (статический расчет конструкции). После этого следует перетащить ячейку Setup блока External Model в ячейку Model и Engineering Data блока Static Structural. Нажмите на ячейку Setup блока External Model и выберите из выпадающего меню пункт Edit. Открывается окно Data Source, позволяющее загрузить необходимый файл *.inp. Выбираем нужный файл и закрываем окно. Теперь блок External Model может быть обновлен путем нажатия правой кнопкой мыши по ячейке Setup и выбора в выпадающем меню пункта Update. В результате выполнения вышеописанных действий заданные свойства материала будут загружены и по имеющейся сетке будет построена геометрия, и модель будет готова для проведения статического расчета.

[bookmark: _Toc516432175]3.2	Конечно-элементный анализ образцов губчатой костной ткани

Образцы губчатой костной ткани после импорта в пакет конечно-элементного анализа Ansys Workbench 18.2 представлены на рисунках 3.4-3.6.
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Рисунок 3.4 – Вид первого образца после импорта в пакет конечно-элементного
анализа Ansys Workbench 18.2
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Рисунок 3.5 – Вид второго образца после импорта в пакет конечно-элементного
анализа Ansys Workbench 18.2
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Рисунок 3.6 – Вид третьего образца после импорта в пакет конечно-элементного
анализа Ansys Workbench 18.2

Зададим каждому множеству элементов соответствующий тип материала. Во вкладке Geometry каждой компоненте Solid Body в нижнем поле Details of «Solid Body…» → Material → Assignment из выпадающего списка выбираем материал с соответствующим номером. 

[image: ]
Рисунок 3.7 – Диалоговое окно Details of «Solid Body…»
с заданным типом материала

Зададим граничные условия, они соответствуют жесткому закреплению всех узлов, принадлежащих плоскости нижнего основания z=0. К узлам плоскости z = h верхнего основания (h – высота образца) прикладывается вертикальная сжимающая нагрузка. 
Во вкладке Named Selections создаем 2 новых множества узлов, правой кнопкой мыши кликаем по Named Selections и выбираем Insert → Named selection. В поле Scoping Method выбираем Worksheet. Для верхней и нижней плоскости задаются соответствующие параметры, они обозначены на рисунке 3.8-3.9.
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Рисунок 3.8 – Параметры поля Worksheet для верхней плоскости 
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Рисунок 3.9 – Параметры поля Worksheet для нижней плоскости 

Следующим шагом задаем граничные условия и прикладываем нагрузку соответственно к узлам нижней и верхней плоскости. Переходим во вкладку Static Structural → Insert →Nodal Force для верхней плоскости и Nodal Displacement для нижней плоскости. Силу прикладываем на сжатие по оси Z равную 50 Н.
Для проведения анализа выбираем нужные нам данные расчета, заходим Solution →Insert → Deformation → Total и Directional. После этого Solution → Solve.
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Рисунок 3.10 – Выбор необходимых результатов 

[bookmark: _Toc516432176]3.3	Определение усредненного модуля упругости губчатой костной ткани

Для определения усредненного модуля упругости образцов губчатой костной ткани использована формула 4.


(4) 	,


где  – усредненный модуль упругости,  – усредненное перемещение верхней грани образца, остальные обозначения имеют тот же смысл, что и в формуле (3).

[bookmark: _Toc516432177]3.4	Определение радиуса пористой структуры

Пористая структура, разработанная в ходе данной работы, может быть использована в качестве имплантанта длинных трубчатых костей человека после хирургических резекций только в том случае, когда упругие свойства пористой структуры совпадают с упругими свойствами костной ткани.
По средствам изменения радиуса стержня пористой структуры определены такие ее эффективные модули упругости, рассчитанные по формуле 3, которые соответствуют усредненным модулям упругости губчатой костной ткани, рассчитанным по формуле 4.
Для каждого образца губчатой костной ткани были подобраны 2 пористые структуры с разным шагом сетки так, чтобы упругие свойства образца и структур совпадали. Способ закрепления нижнего основания и сила, действующая на верхнее основание, одинаковы в обоих случаях
Рассмотрим первый образец губчатой костной ткани, который был получен из области, представленной на рисунке 3.1. Усредненный модуль упругости этого образца равен E = 880,244 МПа. Эффективный модуль упругости регулярной пористой структуры объемом 32x32x32 мм3 (8x8x8 ячеек) достигает такого значения при радиусе стержня 0,001444мм. Для структуры, объем которой 32x32x32 мм3 (4x4x4 ячеек), то есть длина ячейки больше в 2 раза, эффективный модуль упругости совпадает с усредненным модулем упругости образца при радиусе стержня 0,002599 мм. Графики зависимости эффективных модулей упругости пористой структуры от радиуса стержня представлены на рисунках 3.11-3.12.

[image: ]
Рисунок 3.11 – 1 - усредненного модуля упругости первого образца;
2 - зависимости эффективного модуля упругости пористой
структуры объемом 32x32x32 мм3 (8x8x8 ячеек)
от радиуса стержня

[image: ]
Рисунок 3.12 – 1  график усредненного модуля упругости первого образца;
2  график зависимости эффективного модуля упругости пористой
структуры объемом 32x32x32 мм3 (4x4x4 ячеек)
от радиуса стержня

Усредненный модуль упругости второго образца губчатой костной ткани, который был получен из области, представленной на рисунке 3.2, равен E = 689,099 МПа. Эффективный модуль упругости регулярной пористой структуры объемом 32x32x32 мм3 (8x8x8 ячеек) достигает такого значения при радиусе стержня 0,001278 мм. Для структуры, объем которой 32x32x32 мм3 (4x4x4 ячеек), то есть длина ячейки больше в 2 раза, эффективный модуль упругости совпадает с усредненным модулем упругости образца при радиусе стержня 0,0023 мм. Графики зависимости эффективных модулей упругости пористой структуры от радиуса стержня представлены на рисунках 3.13-3.14.
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Рисунок 3.13 – 1  график усредненного модуля упругости второго образца;
2  график зависимости эффективного модуля упругости пористой
структуры объемом 32x32x32 мм3 (8x8x8 ячеек)
от радиуса стержня

[image: ]
Рисунок 3.14– 1  график усредненного модуля упругости второго образца;
2  график зависимости эффективного модуля упругости пористой
структуры объемом 32x32x32 мм3 (4x4x4 ячеек)
от радиуса стержня

Усредненный модуль упругости третьего образца губчатой костной ткани, который был получен из области, представленной на рисунке 3.3, равен E = 548,871 МПа. Эффективный модуль упругости регулярной пористой структуры объемом 32x32x32 мм3 (8x8x8 ячеек) достигает такого значения при радиусе стержня 0,00114 мм. Для структуры, объем которой 32x32x32 мм3 (4x4x4 ячеек), то есть длина ячейки больше в 2 раза, эффективный модуль упругости совпадает с усредненным модулем упругости образца при радиусе стержня 0,002052 мм. Графики зависимости эффективных модулей упругости пористой структуры от радиуса стержня представлены на рисунках 3.15-3.16.
Радиус стержня пористой структуры выбирался таким образом, чтобы эффективные модули упругости образца и регулярной пористой структуры совпадали. Результаты определения радиуса стержня пористой структуры на основании значения усредненного модуля упругости для различных образцов костной ткани представлены в таблице 1.
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Рисунок 3.15 – 1  график усредненного модуля упругости третьего образца;
2  график зависимости эффективного модуля упругости пористой
структуры объемом 32x32x32 мм3 (8x8x8 ячеек)
от радиуса стержня
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Рисунок 3.16 – 1  график усредненного модуля упругости третьего образца;
2  график зависимости эффективного модуля упругости пористой
структуры объемом 32x32x32 мм3 (4x4x4 ячеек)
от радиуса стержня






Таблица 1. Усредненные модули упругости образцов
костной ткани и соответсвующие им радиусы
пористой структуры

	Образец губчатой костной ткани
	1
	2
	3

	
Модуль упругости , МПа
	880,244
	689,099
	548,871

	Радиус стержня пористой структуры объемом 32x32x32 мм3 (8x8x8 ячеек), мм
	0,001444
	0,001278
	0,00114

	Радиус стержня пористой структуры объемом 32x32x32 мм3 (4x4x4 ячеек), мм
	0,002599
	0,0023
	0,002052



На основании сравнительного анализа полученных результатов упругих свойств образцов губчатой костной ткани и пористой структуры и подбора радиуса стержня пористой структуры таким образом, чтобы ее эффективный модуль упругости совпадал с усредненным модулем упругости образца делаем вывод о том, что модель регулярной пористой структуры может быть использована в качестве имплантанта для длинных трубчатых костей человека. Имплантирование пористой структуры в кость позволит сохранить ее прочностные свойства, а строение структуры позволит костной ткани заполнить полости.


[bookmark: _Toc516432178]Заключение
В настоящей работе разработана конечно-элементная модель бедренной кости человека с учетом реального распределения минеральной плотности губчатой и кортикальной костной ткани. Так же рассмотрено конечно-элементное моделирование параметризованной регулярной пористой структуры.
[bookmark: _GoBack]Проведен анализ зависимости эффективного модуля упругости пористой структуры от ее механических и геометрических параметров. Следует отметить, что анализ проводился лишь для одноосного сжатия, для других случаев нагружения может потребоваться дополнительное моделирование [3]. Установлено, что модуль упругости структуры не зависит от количества ячеек, но зависит от радиуса поперечного сечения балки, из которых состоит пористая структура. Эффективный модуль упругости пористой структуры зависит от модуля упругости балки.
Выполнен конечно-элементный анализ образцов губчатой костной ткани, полученных из проксимального отдела бедренной кости человека. Определен их усредненный модуль упругости.
Проведен сравнительный анализ эффективного модуля упругости пористой структуры и усредненного модуля упругости образца губчатой костной ткани. На основании значения усредненного модуля упругости для различных образцов костной ткани был подобран радиус стержня пористой структуры, чтобы эффективные модули упругости регулярной пористой структуры и усредненный модуль упругости образца совпадали.
Таким образом параметризованная модель регулярной пористой структуру с низкой плотностью открытых ячеек, которая была разработана в ходе данной работы, может быть использована для имплантирования ее в бедренную кость человека. Имплант позволит сохранить прочностные свойства кости, а его пористая структура позволит костной ткани заполнить полости.
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[bookmark: _Toc516432180]Приложение А
/prep7  
*SET,xmax,0.032
*SET,ymax,0.032
*SET,zmax,0.032 
*SET,dx,0.004 
*SET,dy,0.004
*SET,dz,0.004
*SET,xn,xmax/dx+1 !number of nodes in 1 row in X direction  
*SET,yn,ymax/dy+1 !number of nodes in 1 row in Y direction  
*SET,zn,zmax/dz+1 !number of nodes in 1 row in Z direction  
*SET,z1,(zn-2)*xn*yn+xn+(yn-1)*xn+xn*yn
csr=0.000409578 !radius of beam cross section
!---------Nodes Generation----------
*do,zz,0,zmax,dz
*do,yy,0,ymax,dy
*do,xx,0,xmax,dx
N,,xx,yy,zz 
*enddo  
*enddo  
*enddo  
!---------Elements Generation---------- 
ET,1,BEAM188
SECTYPE,   1, BEAM, CSOLID, , 0 
SECOFFSET, CENT 
SECDATA,csr
!connect nodes in X direction   
*do,kx,0,zn-1   
*do,jx,0,yn-1   
*do,ix,1,xn-1   
E,ix+jx*xn+kx*xn*yn,ix+1+jx*xn+kx*xn*yn 
*enddo  
*enddo  
*enddo  
!connect nodes in Y direction   
*do,ky,0,zn-1   
*do,jy,0,yn-2   
*do,iy,1,xn 
E,iy+jy*xn+ky*xn*yn,xn+iy+jy*xn+ky*xn*yn
*enddo  
*enddo  
*enddo  
!connect nodes in Z direction   
*do,kz,0,zn-2   
*do,jz,0,yn-1   
*do,iz,1,xn 
E,kz*xn*yn+iz+jz*xn,kz*xn*yn+iz+jz*xn+xn*yn 
*enddo  
*enddo  
*enddo  
/VIEW,1,1,2,3   
/ANG,1
/ESHAPE,1  
eplot
!-----------material models
MPTEMP,,,,,,,,  
MPTEMP,1,0  
MPDATA,EX,1,,1.7E9  
MPDATA,PRXY,1,,0.3  
!-------creating components
NSEL,S,LOC,Z,0  
nplot    
CM,nodes_fixed,NODE 
CMSEL,A,nodes_fixed 
allsel,all
NSEL,S,LOC,Z,zmax  
nplot    
CM,nodes_top,NODE 
CMSEL,A,nodes_top
allsel,all
EPLOT   
CMSEL,S,NODES_TOP   
CERIG,Z1,All,UZ,ROTX,ROTY, ,
!-------BC----
/sol
CMSEL,S,NODES_FIXED  
nplot   
D,all, ,0, , , ,ALL, , , , ,  
CMSEL,S,NODES_TOP  
nplot
F,all,FZ,-100/(xn*yn) 
EPLOT   
ALLSEL,ALL  
SOLVE   
FINISH  
41
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